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For information on See page
Product overvew 1-1
Battery and AC power 1-5
Instrument module installaton -1
Power on and functional check 1-19
Touch-screen calibration 1-20
Operating instructions 2-1
Onling help 2-10
Menu descriptions 3-1
Battery care 3-3
Memory resources 3-15
Floppy disk storage 3-17
PCMCIA interface 3-19
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Upgrade software, change lanquage | 3-31
Technical speciicatons A=1

For information on See page
Accessonies B-1
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[iagnostics D=1
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BURFE 23 1—11
A v, Fa Ty R A ] 1—19
fik B FA 1—20
EATVLA 2—1
TE A B 2—10
ER AR 3—1
Wb & F R 3—3
Btk 7y ik 3—15
AL Ak 3—17
PCMCIA 3o 3—19
it s%h PC &4% 3-27
TFREM. KRBT 3—31
FHAAE A—1
P A B—1
Y$ip C—1
gLl D—1

T3 451

NetTek 5 4LF & KA AT HA 69 2R3 &) B AF (384T) e 47
TFALE , L E R, RIBATAE /o

HTAIFHFBE o AR M L IR E S 4k Start>
Help. # R st 224 & XALE 69442 E T A4+ 49 Start, K 5 22
HERME CE X246 Help, A0 2—1 X ThofTAmERF Liz
HAHH BAFIAN L.
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Y350 NetTek 5 #4L-F & £ #F OTDR 45 NetTek # 7 F= A 5580
AR X T B AR H X A ITABF & F 3 A KRt %o

EELD &N

AF M I 7 NetTek 54 BL-F & B m A 1.0 Atz EARE
PR R, BEAT VAT B4k

1. & Start>Programs>Tektronox Utilities>System Configuration.
2. 477F Hardware #7 %
3. it Platform, & & & Properties.

BEA 7 A

w,7%:1-800-833-9200*

Hoht:
Tektronix, Inc.
Drepartment or name (if known)
14200 SW Karl Braun Drive
Py, Box 500

Beaverton, OR 97077
LISA

M hk :www.tektronix.com
45 % #:1-800-833-9200, i Option 1
F A % 3%:1-800-833-9200, £ Option 2

Wl ETRALE R ER, THEAEZEATE S, £l
EVISNI T, T 5 R A ERARRSHERIRRZAENEL
HELT AR E M LS 3],
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K 1-1 Y350 NetTek 5 #L-F&

NetTek 3L -F 4 2 —ANFHXE BT F @, X
# NetTek AU EAE 2 7] 69 X, T B, NetTek MX T EZ 7 %A%
LS4 . Bk fe LA R L AN R &It

RTH % 2 4 R A RAE e 53 3] NetTek /\#J'T'fi"?‘é‘ D)
Jado MBS M KX T LBIARELRS FE6KE,JFALEA
EJ éﬁ #ﬁ)\\ #ﬂ'] th 3\.;}% o ﬁg’f%/m' m 2&&&45 S o

WindowsCE #:4f & 42 5 X ik B & 2 -F G A2 5 Fe il f3 o
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@ity X PCMCIA A K R SR #] A 98 25 A o7 B8 P 4 BBk
M &P RE o

Y350NetTek 5 AL-F & & Frbtde T

o MERZHMILENLE DT

o BEIRAALK LM

o ATHAENED

* REWIMLALMERE

* I RIEAF

© NEEHFHFS

o THEMAX L

o BREA AN AR

& AEAREAT AN IR bk w49 NetTek 544 5 SURABE S 2 7T,
LIRS O A R BSE &S ILFM 3T T

Tt 5 A

& 1—1 &4 NetTek 5 BT & T4 5 M489 — 15 &, X
RS A0 R EF R, AL B-1 RS 69 R B

& 1-1 upF 5 AR
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Battery Calibrator and Charger.! ? Charge and calibrate
MetTek Analyzer batteries. Holds two battenies. See the list of
optional accessories on page B-2.

CD-ROM. Install language options and software upgrades from
your desktop or laptop computer. See page 3-31 for additional
nformation.

Desktop Power Supply with Cord. 2 120 VAC to 24 VDC. See
page 1-10 for additional information.

Hard Carrying Cases. Transport NetTek Senes products in
these rugged carmying cases, altache or steamer trunk available.
Soee the list of optional accessonies on page B-2.

Instrument Modules.? Perform OTDR and base station analysis
with MetTek Seres instuament module test tools. You must
purchase these products separately.

In-Vehicle Power Adapter!: 2 Operate the NetTek Analyzer from
your vehicle and charge batteries: 12 VOO mput 24 VOC output.
See the list of optional accessonies on page B-2.

Keyboard. Use the miniature keyboard to input text or issue
commands o the NetTek Analyzer. See the ist of optional
aCoRsSONes on page B-2.

—

L WK EB AR

5t NetTek oA e b Sk A, 5 2 e b A 0L, B—2 it 4
Ao

CD-ROM

st & XKL ©In L E 57 R IT RN R £ %12

B 5 F M 3-31 W

& X WiR4E4

120VAC 2] 240VDC., # i1z & A NLFH 1-10 .

AR 3B A

) iX sk 4t 15 4, B35 NetTek 2 7)) & %o, 5T B F 32 3 A5 B KA
A NFMB—2 mittF k.

A EAE 3

& A NetTek & 74 AE S w1 X T B 5247 OTDR Fo &3k 574X,
A9 G250 7 91 Ty 3E 3K B S

ESE VRl

FEARE F 48 0 NetTek 5 HiAlA= 2w, 7 4,:12VDC 4 A 24VDC
b, R LFH B-2 Tk A K

b
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R s B A A N S5 326 NetTek 5 AR 45 4, 52 L5 #F B—2
PG

locations. The product includes one battery as a standard
accessory. Additional battenes are available; see page B-2

D Battery. Li-lon battery to power the NetTek Analyzer at remoti
optional accessones.

/jf Screen-Protector Sheet. Protect the touch-screen display from
abrasion and scratching. Available in packages of five. See
page C-1 for additional information.

Shoulder Strap. Attaches to the top of the NetTek Anabyzer for
@asy carmying.

———— Soft Carrying Case. Protect the NetTek Analyzer and organize
= your accessones. Lse the soft case to transport your test
eOupment to the measurement site.

Strand Hook. Hang the NetTek Analyzer from a wine strand or
other support. See the list of optional accessories on page B-2.

/ Stylus. Use this tool to tap the NetTek Analyzer touch-screen
display

Tilt Stand. Supports the MetTek Analyzer in an upright position.
s the tilt stand for bench or desktop operation. See page 1-13
for additional information.

] User Manual. Contains information on set up and basic
operation.

& A-1 5 A (4)

v, R 3E AL B e AW 3R R AR UK B VAT 6908 AT A, B B L R
ITHERT P

*RUFEAR B 69 IR T T A Fe NetTek 5 AL & R —4E, L3R 3%
HAE B AR B AE 3 ) P T Ao

8. &b
T 32 5% A A 69 o 77 AL 35 T wdu 2 NetTek o AUt &, = 3 4
AR e — 3 W, 38 T B e W, A LT B-2 Wi A

9. Btk iE
PRI fR BT LT o B A, 0% PR 5 R ,iEm1z & ILF M C-

17,
10. %

www.tek.com.cn 8



YBT350C NetTek 54X -F &

a2k 2 NetTek 2 AL 69 TR 3R LA A o
11, 2RMEEH
37 NetTek 5 WAL 228 B & T4, B 3RA%8 35 45 2635 1R 69 M) 4R 3%

ES I DUREE S
12. #4
F &R & REAME LIEMFF NetTek o4 AL#ER, A NLFMHB—2 7
H AR
13. k%

At T 32 & NetTek 5 WALk 3 2 7 5o
14, Mm4H4
X 4 NetTek 5 AR A 20942 E . AMAR L#TE AR 2 \mE
VB, w1z & 5L F M 1-15 T
15. M P F#H
8.3 5 Fe KRB RAEAZ o

ZR Bk
NetTek 5 AL L) K& i %R R i, A T BAf 5 AL
&R A, R AT AR P Z R ik

iz % :NetTek S HAUFF A B B —He ik, AR T ho § = e Wik 1A3E
KAOHALE) TAR BT 1] o 7T AR A 2 8] W 2 — 3 b, SE 2 3%
5 AL F# B-2 ® & B-2.

1. 4 NetTek 2 #BUi £ F & LAk SR &7 @ 418, ) i 2 i 411
kLB 12,

2. Gy ML S 77 e 114

3. EARB AT B ATBLE B T4 o
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Eattery
ﬂﬁﬁf-"‘ﬁ'm'ﬂm' companment door

B 1-2 NetTek 5 #AL &, &

4. KB R 24, LA 1-3.

5. AR F 3 T HEN AFRABRE T,

6. L3 Wi E T @ IALE G F ), Ui, ARG AR T
RHFE WAL E

Battery retaining door

Battery retaining tab

A 1-3 kB Zf R

7. BB M AL AN, w R B L e B 1—4 B
TG e, AR R NS I B S Shar BT R T A,
=
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BB AET .
8. ¥ ¥kt &,k AL B A B R
9. s WE T W T E4E ik, K5 T/E LD EEvk 5,
10. XMFH R ke,

Battery retaining door
in open position

Batbery removal strap J 2D
e -.'. | /
4

B 1-4 25 &

BEY

e

AN BB, B AL R T2 AW, AIRIE WG
Wk U, #EAT VAT 44k

1. it Start>Settings>Control Panel.
2. IT (M E) wik 4 12 [ 4%, Batteries 4747 4 (35 7) A4 ©ibk &,
HARCTRELSRFM 37 R wki b,

EREEFH

AT T e T A fe Ak i TAE BFE] K, AL NetTek 4 474X
1% % 8, Start>Setting>Power Management.
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PP @k

RA TS BHF T REZALLRE A,

1.

oo~ wh

F NetTek 5 AT AT & L A& Ak 27 @ G4k, B B w0 &
AL LA 1-2,

LR AR SRR P U= 8
EREBETI R G ITAUE T,

B 2R R 2L, LA 1-3,

A FHETREER ACR)BLEEE 2],

LB 2T HLE @ o MR B 7 AR, LR ERF T AR
B Wi E

Lk, Bl vk, LA 1-5,

Battery remaoval strap ‘G

A 1-5 B vk
EBIABEE I RAIF R e, 1-7T Ty BT M T7—10
89 350 IR RAE o
HEEXWR

B

AR TFR2EmRE XAINF LRSS, T 1-6 FrrFs X
B 4 4% 3545 %) NetTek 4440
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i 7] 694 ¥, 08 2 100~240 VAC 50/60Hz, 47 3 ¥, 3B 46 %, i 1 4
F# B-1 M B,

K16 & Xkt d
RHFERACRERSE

AT Fp Wl R RBEATI SR, T B 1 =7 BT 5 &
A &R E B & %4 5] NetTek 54740,

Plug inte vhick:
12VDC power outhet

B 1-7 £ wRERS
LR AN BB

FR T 5 BT 45— BAALHe 4242 5] NetTek 5 #ALF & 8
o AR SR 4 5] B — B, B ILE 1-9 FE 69 A3 B

1. %7 NetTek 54 & 89 iR, Bk £ T A 69 KAl I & B4,
2. FH4r L NetTek 2 W ALF & Ao BUR AL e 69 P17 12 4
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. ¥ NetTek 2 WL @A T LF& LA TG A %EF L LI5S
AL

. M NetTek 5 AT & A A b9 F B AL KT, LA 1-8 &
A 1-9;

NS HEALER AL B NetTek AT & VAR 2 0943 69 L,
AR E R &REHES, LA 1-9;

. BB R T AR A NEE BT AAR B AR

BB AANF AR LATHALE LA 1-9;

o XFHEASTFar 3R LLAT, K BRE T 4% BB AF T e g K B R A% 69 KR

K 1-8 # A& &I

www.tek.com.cn 14



YBT350C NetTek 54X -F &

9.

Bus door

Thaemby screw (4)

Instrement modue

MetTek Analyzer
Platform

A 1-9 2R AURAE S

@ IR A4 T o) 2 S B L AT e VA B e AR 3G e L3R, ST AT
N T AR LLAT TR 0948 F B4R 39 5 b B 5 3R 58 2247

10. A T I& R F 7 5% L2 4T 3k 30, 3% Fo I B 4T 77 15y e 35 4 N SE 22 4T 3K
1. ABRBFZEHA, ENHFLE LKL HPURFE I 53,

# AL RAL S

1.
2.
3.

% B NetTek oM AL-F-& 69 wiR 5k £ T /A XA B % L & 34,
425 NetTek oM AL-F & Fe L FAL e 69 BT A £ 2%,

F+ NetTek 5440 d 3 T & T30 -F & L, g e A 4% 0 &
XAZH AT

ANTF 57 3R 24T 5k, e 15 B AT T 18 3% A% OF die R B AN R L2 4T Sk 3R

¥ 15 B AT 77 6] Ak Ak BT R w9 AN BR Z24T Ak N T A e RIR 24T KE
8945, 7T it & B T L S AR ae 4%,

) B AR S e ok

APRH R A A AR E &R ITL K3 NetTek 5 M- & AL EAE
Bty a3

REMER
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AT 2@ RE XA, 4R 4% 3] NetTek 54 405F
HEFH B 1-10 95 E

Attach tilt stand with
thumb screws {3)

Tilt stand

Stylus holders

@‘\ Bottom thumb scrow

located under Velero flap

B 1-10 A1 4422 % 69 NetTek 5 4r4L

j]ﬁ%’]%‘ 2 /1\VXLQ’?”{X%%&&%E%%@]/fr}n:@,]_;ﬁ'}»_,'ﬂ‘%}ﬂ A 1
— 11 49 1A B3R A4
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‘edcro fastener
Tl stamd

Instrument
madule

Additional
insfrument madule

B 111 2328 2 MUK R R F R

BRFF

%o B 1-12 P & A

KL

, AE 4 5 NetTek 54740 2] TR I

A 1-12 22 4 B 4 49 NetTek 4 #14L

#A A& (L)
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T 3T A KR b KA I NetTek i ilitde, & K s b
% e B 1-13 Fr .

E ARG 2 0 W Ae SR AL 3 69 402 NetTek o il é) £ 2 T
AL 12 (25 #), # & B AEAT I AT B 0 AT £ iE

TEE

A 1-13 A& & E4 4% NetTek 4 #74L
%> NetTek #7404t &

TFA, ¥ 2 T A 69 KAl B A b4, IR ARS A TOIT L S, —
2AP Ja AT & JF4s TAER

E T e 2 o AT AU W 8 W IR K, s T R R AL &L, 3
IREAE IR WIR R BB,

FEARIT A &

NetTek 2T 4L-F & 12 T HUa 89 A LAY AF MAR R 5576 4 FF
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RFE 6 B A, BT A9 B AT B k. B A A KT AR
BB B 4ok 1-2 BT

& 1-2 Fraesem

Failure
Test Test description indicator
RAM Test entire RAM with multiple patterns. | 1 beep
Boot ROM Checksum test of fizsh memory, boot 2 beeps
Checksum ROM portion.
Operating system | Checksum test of flash memory, 05 3 beeps
checksum ROM portion.
Super W Verify 110 port controller is responding. | 4 beeps
U M X B W T
RAM B %A B AR K 4% RAM |1 5

FIALR | BN BT AFR, AR (2 5
ROM #.#% | ROM

B R G | BN BE A 2,08, 37
B ROM

BEIVO |[iEL /O spuks Bhm. |44

X BT, — AR A kA, AT & 323K
3 FAL A do 31 R, — A AR B I, R R P e R BRI T £
o £ HRTE BAEIT R IE A AL RO B, KA W LRt
o JAedd 4 K9 5L B D-1.

B AR B A BT

Ay A% fik B Br-Ak TE AR v oL AR B9 fik 32 (42 38 ), AR o0 SR AR B R
BRI S,

R EA AR R

1. it Start>Settings>Control Panel
2. IT I (k)4 Ak E Ao

www.tek.com.cn 19
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3. 7= Double—Tap #7 % £, B4R &9 F 45 A4 fik vAE & 69 i B W& 75 A&
FOGHME, AR TR R R
4. 3P BE VAGE LR 6935 o

REA AR P S

1% Start>Settings>Control Panel

3T T4 Ak B AT

1 Calibration 47 4 L it Recalibrate.

AL AR B Frve AR B B2 B LR TR R FE R E RS K
o VER B AR S EWGE S 4 5 WAV R AR B IR AR 2 E

it OK XL X A 3F1EE o

F B AT @ A WIR T K, VA AR5 IR

7. F4210s Fa)E A @R R I &, B R EHFAEIEAT

> wh =

o o

B AT A Yo #74% & (Start>Programs>Tektronix Utilities>system
reset), /£ 40 W, )5 B 3140 4540 fik B FEAR £

187 NetTek 5Lk

Fo— G 245w fa (F3%) 10, NetTek D F AU Sk i(—‘?-ﬁi 49), A
IR, LA Al w5 h

FieH X

R R A7 I T 48 NetTek 5Bk T —HFF 4 45 (L) R & o
XA SR GGl W g X, AU L AT A AR A S R R B R B A
BT o o Ry ABARFFAG AT X o9 ot X (2 2 ) ), ¥ B sk
BENWT T X B B S KA ST R B Rk, AT —H ik
AL ATBGEAT T A7 7 K

° Al AR LRI Ko
e % Start>Shutdown, £ Shutdown »f+%4E ¥ i Suspend.

FH AT 7 NG, A E S E B R 7]\ A8 IR IT X, 9
MUK 2] 3¢ 5 69 R A AR 2R P BAT B AT 7 Xl 694 2L
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% H

A R B ALY R, 5250 A T ARk
1. i Start>Shutdown.
2. 7& Shutdown xf4£4E ¥, Shutdown,

— R EWFHF R — K G KA, LIEF TR S AT e H 498U
A B R AT, EA AN KA S AN XK IE. A KA AT
X e N 53 3k 5 kA 5 P 6915 8, A& NetTek 5 LT & &
A8, & Start>Help(#% £ TEHR#E S W),

A #H8E v ik Tektronix Basics; X & i& Store Data in
Nonvolatile Memory.

FE X WG B A @ AR IR TT R B, 9 ATAUE 29— o it R A
IRIBAT 23R W TR, SUBTAR o0& I Am BAL AL e SR AR, TR JR AR AR B 3 AT
T AT BB T8 AR

H Ko AL TFAUG b B 6945 &8 B £ & B, 1L Start>
Help £ & #5 85 & v F i& Tektronix Utilities>System
Configuration>Software Configuration.

EHRH(RHEE)

AT E#HB NG HALFEA T
1. & Start>Shutdown;
2. f& Shutdown % v x}4&4E ¢ & Restart.

BREGY S AR T e RELE A, RSB F) )G B
BITENARTF ENMBNRREN D KRG E

TR BRI X

He B AT E AR CIRIT X KT S H Ak X —!
o EH ML T RAKE, FAT AL,
o EoMBLTEATRE, FBHFIFH X,
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WAL T 17 75 X, KB B 17 7 X, B B8 3 o AL
H WAL T e N (AR R 75X A), HEE T

HEKREEFX

KA @ BALAE E BT X 6945 &, S LT 2-2 W

BibAZ 2 EEHEGF

B AL AT 2 FAGF AR T i, 2 AT

o

A R SR AT IR LT, &

HINEAR LA F W,
AT B M R ATRAR, A AR L E R fe I W89 5T ALtk
W AFZEHAE BT RRA LY TR, B2 F A RITAERRK X
"“ﬁa%%ﬂﬁz@ﬁﬁé‘—o
RARG B EF B RA B AL, Y F T e 5EMTEETE P
//.?wfa %,
R AR B T BT AT e — AR IR IR LR B T F &
Jo RAR B SABUR EIE R L& T F H LT 69 IR BT, R 0L M IEBTAUE
REHEEA LR VR FAE;
M Sk B TR EFHOETER L, 0 2F
9 2R, A WLk A AR P L
333:\5@ TR FERARPTAENR A F LEH, AL = BRI, 3]
PREBNAEZARTRELATETFELELEGERT;
ﬂﬁ‘—;*sk% A AR A, IR RB LR A K. B WY, HE
’L%’L AR 5w 2 SR,
AE A 7 B B I A A 5 RPN F R R R
éé %ﬁfik/;{’fﬁ%é\i 2 %Y,

B HNRT B YR
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o LFEATRE, FRAECAFA—BTHEA—ZIEB R
K% B T30 K 69 3% o ATRAE KB A R 7 R — AN
B0 R, M) 5 BT A 2 B IR, AAKAL T 48 2 345 &

o ERETELLGYrh T MK N -FK, 5o (1) & 4 M KAk
A W 89 4B B, A AR K 8 B B AT

o feiHEA RN RE KR T LB KN LLI AW b
EEF;
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Bk K

PRtk Emh
AT 24 NetTek HATHLF & A % T ik EM M HAES &

o RAIEH. EHEEBTE
TALH N i i o Ak SR 1

s THAFIHED
o AL B
o BAUEAL e B AF
o B Mtk
NetTek 5 AT & 4 ) ik 32 5 2 5 4T Ak B4 Ao RAT

(A T4 &, LFM B—2 ). AR tfia & Xt b4 A R AT
— AL AR R — AN B AR EREE (B T). B AAREFR LY
), & LI T B RS (E3)) B AR & L0 &,

E B AR ) A AR ) de B R S AR GG T35 22 AR B B
WM R e LA B, C MM T AT, AT
HE BT B E AT M C-3 | _EeLEA

RAIN AT BRIER I TSE

R R AT d # A ) 2e NetTek 2 AU X wiR, & B 5 AT AL
Bk RBAE RS o
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G
P

R R )
el

p

A 2-1 NetTek 4 #ALa] @t d=H) B Ao ds T &

1.

W, )R /%5 1% (Power/Suspend) JF % : A % s JF % 89 69 m -4 5 5
M1-19 =2 1-21 I,

% # (Reset) JF k w R R G EIRE He o FF R APATRM T E, ) —
Rl 4k R4S LR BIEIT AT @R FEART X, §T B
SERLETENG XA BT HRT
KREBTEHZERTMEEFERTETARALT T i X
BB TEGECRTERAEAALLZERTEERAL, FEER
AEEREN20% 8, BZREBTITR. YRERELELEH 5Y
if,NetTek 548Uz 30 74k &1 F) B K Lo

RALN. W 5 AMEE

B 2—2 5K 2—3 35 NetTek o AU A #r b 5 G453 449

(A A

> whnh =

I BRI 7 AR — SN ERSRAE A TR BRIEAS

RS-232 3% v ik 3 — 303014 A T B BR384Z

Brfs i —3 PS2 4 Az L 1-2 .

Sroh & m 1A 5 A SR E L 49 IrDA Sk o v S4F U 538 43,
HHefz 80 3-21 W,
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1 Fi

Ladetaty

i 2-2 NetTek 5 #1406 #r N 5 % b

5. sk FAUEILEHE 3.5mm(1/8”) A 24835 k% FhL, L v RE R
A2 T,

6. M3 EH E5LEH 3.5mm(1/87) L2555, L B RKRE R
WLA—2 .,

r_.r.j_q

[:b LR e i)

7 2-3 NetTek 5 #rAL e 537 A%, BB 3 A L5 44556 4

7. RREH NBEFEHOILE,

8. PCMCIA 5% o :PCMCIA II& 3% v 6945 &, 442 & 3-19 T

9. BAIWMHH(EH) LA KRERH 9L E, Lz &0 317 .

10. BHFEBNEYFENILE,

M. AALRENSEHESE A LB RAEN LRERE, L8N
1-10 4= 1-11 7,

FARE

NetTek 24 2 @ AR L& T TR, 2 @B BRI
R A R R A BT VAR AN E AR B ] X T AL,
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Deskiop

=
-

. Tektrun/ix

uuuuuu

EE= T RF T saemm 4]
Taskbar

& AR
5 2@ b6 B AR VAR AT I A R SRe S AR T o

HEHFAE(ESF)

1542 O35 8 3 5 2 B AR E L BATAL 5 09 4, — ANR A
X, — A & B 4o
BhES

B U8 3 A I B Fe B AT AL S 5 FAAL P A R R, AT
T XA VA R GEZH B i (42F)Start YT E 8 KRG IR T B9 A

o,
HEFLRANZEEAL3T1 AR LGEABHEL,

Start mend Desktop button
At e // |} T i 412 P F‘g
Program button Sbatul anea
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B Settings
&5 teip
E1Run...

B Bogars ¢
] Favorites F
5 Documents *

¥

B Shufdown

Select Start to open

B4

A T IR IEAEBATAL ik LA S AL B A T G842 5,
Rk shdsa,

KA K

Z LA LR IR B AR de 4 ds TR A BE A, AT IR
HHE AT HRE L8 RXEFZBIF. & 2-1 -5 K
SRAF L

A RAHRS R ARG LA L 7267 &, 5 5 L NetTek
DAL & A By, & Start>Help, 74 85 % = & Win-dows CE

Basics; %k jz it Understanding Taskbar Icons.

% 2-1 KERBHE A

Tap this
icon To Details
ﬁ Double-tap to open the Power The analyzer is operating
Management bty on extemal AC power.
fé‘r [ouble-tap to open the Power The analyzer is charging
Management utlity. batteries.
= [ouble-tap to open the Power The analyzer is operating
Management bty on battery power. Also
indicates charge level.
U] [ouble-tap to open the Backlight | Adjust the backlight bright-
uitiity. ness.
ﬁ Single-tap to open the Input Singhetap to chose the
Panel soft keyboard. keyboard.
4:12 PR Double-tap to open the Date/Time | Set the date and tme.
utity.
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5%k WA AR 3| LA
M o B AR, 3T I IR AT 3L | 2 AT BLEEAT I3 3R IR
A,
WEHATTFRRIEH KE DAL B3 7,
WEHAT T RRIEH KE S HTALE LA &, F A

ECRR

BEITTFHAEE W H R .
¥ HAT AR LR A ITHEYEAE
b,
Mk 3T 7T B A/ B 1) E &€ B H Ao Bt ]

x B ¥4

& 2 B AR DM 2SR EAT R AL A MU R B B R\

BRFYEE T EM A

BARFE BHT, K S BRPRAH S BLSELOERE
AR A BARYEAL T R 09 T A2 B4

Menu fithes Slider Toolbar butions
A, A
r b r 1
Eon Edit Wiew Go Favormes | [ [m] <o m -] [=]x]
[ HatTes

Hama Sire | Ty | Mocified
Address field
REAFA
AATTHF— KPR (BHF)ELL ARG RREZOAND,
& H(R)

HIHARBRARAAN R T T EAZRARKEL o T LA
BAZ AR, RT I F R TIT R A Fa KRG ARAAT I
FE P TA ) T EAZ A E] X4 T @
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I B4
AT AT T BAZ e o AN A ik (R F)iZ 4.
VRN

Wy — MR A S AR A4 1R 3 BE 3R B N SR
1. M A MRS A ABEMAIA(JLMAR 2—9 |
bR A 5E);
2. ¥4t b oy Return g2 & 8R4F & B 692U N SUR R AT F8
A
A #4474 A NetTek 338 fo T ELAZ 34 69 3o fz B (S H Ak
i 145 &) 50U NetTek 5T & & & 4 8, i Start>Help; & /g it
# 8% o + 49 Windows CE Basics.

EIR REANRP R A T AR R, AR XX Y
BRERAE 2 A LA GBI,

BL A 4 AR (B4 S 4k)

T EAE SN, B3 R AN B IR & e ak
BaE FAT o

Esd 1]2[3[4|5/6|7[8]9]0]|-|=]|4=
Tablglwle[rft]yfuliJolp[[]]
caPlals[d|flg[h[j|kfI][;]"]
shift[z[xJc[v[b][n]mT, /<
ctljauf " [\] Q=

BETLARZKSRE P4 EEF

B2 NG HEN UK
BEINDE)VREAE EXRIPAIT 154
BEREAFAXALE

> owh =
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A TR R B A4 (B 1), Start>Settings>Control Panel
IT - NE 47 24 5 i Options.,

T H

BRAF Ao — S B B F) BT R T ALY F4F
CAP(X5)4

24 CAP(K B4 ) 4 AR = £ 238 KB F&FeF ILF 4o
Shif(#4%)4¢:

bk Shift e > A BNKE FHRTE LFHo
b

52 5S4 VR P AR F Ao
R 8

ARAT TR B E 0,3 4% NetTek WU & 4748 6918 F 13 &,
HErH R Fik Helpo A 7 RKAFR L AT EEAT A7 R — A5 1R
A B 1E 8 82 AR A B A P 89?7 B AR T IEAE
HEhE

& 2-2 BLOA ke AT A% R A5 Bh i 0 548

&k 2-2 W) E v ¥
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Tap this button To

E All Topics Display the NetTek Analyzer main table of contents.
H Back Return to the previous help screen

E Contents Display the current program or local table of contents.

Display full-screen help text.

Display the help text in #s own window. Tap and drag
thix Help window titie bar to move the window.

Close the Help window. To reopen the window, tap
the Help icon in the taskbar.

Cloze the Help window and quit heip.

Scroll the text towards the bottom of the screen

Kol e =

Scroll the text towards the top of the screen.

2Euwg | 3

2~ NetTek 2 £ &N 5k

=] 5| A7 @& 49 H B A
o7 BAT IR KA RN Tk
BB B

ETHTHE BTN B
A e B BB AT A

o

B o

AAWBERAT EHTTFE
AT AW B

*AH BT 2R E B,

Fr XA m EHERFRF

LA T EFRS)

e BRAR e 2K A

A% 8 M X T B AT 2 BF, B 4 OTDR = 2 35 2 A7, AR 5% 4R
FBUE %3 2] NetTek 94L& 49 )5 3% B Bif 3t AL T ROM %4+
H KR F I Ep A, AL F M 1-11 T3,

— EARAE I F AT AR T H T ) e ENABUK, B i35 AT
R = A
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o W& Rd LKA A B AR(—ANRIEIELIAE AP F RS
Rl L) & HE);

o & T E# ik Start>Programs>NetTek, & & 1R B & 1547 69
Instrument Module Application Software>;

e I A# it Start>Programss>Tektronix Utilities>System

Configura-tion /& 544 4738 b i AR BT & 3BAT 49 SR AF 2 A 4, 5K UG i

Load, R4 AE 2 #h i, A sh e hm R B E & A o
EARYEARIS AT L) B E 69 T K AUEAR B AT 42 8 B A

B 3 X hm 2K, o
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BE T
I TE

AT RBE A B FH KL E &AL B KB n B Aeid
ATACRAE e A AR EAMAZ P N TR AT IS G KRR B o

THBHELERLE T PRI T LK dit Start, A X%
ANk R R AT B A LR R A B

# Start 47 JF X 2 % RV A%
» Programs » Gommunication » PC Link Communicate with a \
desktop compater.
= Remote Set up modem and
Networking custom PC Link con-
nections.
= Terminal Emulate a terminal;
connect 1o a server.
> NetTek » instrument Run the selected
module instrument module
application application softwane.
» Tektronix Utilities - Diagnostics Run NetTek Analyzer
diagnostics,
= Module Install instrument mod-
Upgrade ule upgrade software.
» System List properties; load
Configuration  software; set startup.
= System Reset the analyzer
Reset following a software
upgrade.
» Command Prompt  Open a window o enter and execute /
commanids.
1. Ao Ry S ALiB A2
2. & B MR B HRR PC #it ik
3. M —ANin BB — ARG B
4. IBAT BT AR AE R B ) B
5. 1247 NetTek #1489 4 iy
6. 4 EAURAL I A
7. 3 e E AR B A
8. f#H M I BIE E B2
9. HIF—ANE T MBI APATIE 4
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i Start 477X K 1R 1%
= Programs = Inbox Rum Pocket inbox. Send and receive email.
(Cont))

= Start Floppy Disk Start the floppy disk drive after instaling a
disk.

= Imternet Explorer Run Pocket Infernet Explorer. Access the
Intemet.

= Microsoft Pocket Run Pocker Word. Create and view Word

Word documents.

N

= Windows Explorer  Run Pocke! Explorer Access the NetTek
Analyzer file system.

= Favorites Open programs and folders. See Start » Help > Windows CE

Basics > Index - Favorites command for add/remove imstructions.

= Documents Open a document created since the last shutdown.

= Settings = Control Panel Open the Control Panel,

= Taskbar Set taskbar properties options.

= Help Display the NetTek Analyzer mam help table of contents.

= Run Run a program. Enter a name or select Browse to make a selection.

= Shutdown Shutdown, suspend, or restart the analyzer.

IBAT - PRAZ FG, K AR T bR A
%%*$~ & B 3R IR B
EAT 4R AR R B, N R
’%ﬁi%@%ﬁ%ﬁi%i#

AT mn) b 58, 3 NetTek 9 # AL 4% & %4

T ﬂ"%ﬂ%%a A & 7 XA Start>Help>Windows CE>Basics>

Index>Favorites command 3& #h/ &) .45 4~
T — i Bk XA A6 S

. AT TR HIAR
9.
10.
11.
12.

AL SAZ 45 R
27 NetTek 9 #2645 8 N 5k

BAT— ﬁ@%kfx#ZkﬁBmme#éiﬁ

KW HAF R EH B 3 5 A

LA

AFTEETIHEA

WL E & F I
WA AERE
SR IS A
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° RIxwib
o TH(RH)RA Bk
o A ALA R LB

WHLE B FR

NetTek oAUk A 42 & -F (Li-lon) w0k, % 3+ F o £ ) 2 F 3%,
300 R A— M BHEIR. A EKIH e TAE £ IE AT EE F4 T
Y542 LB F o

RETEEHE AR RN LRSS, B ERERLZZTEK LR
&R RT, B3 R ARG T LIRIZ £, Jo RBIEARM 2] 89 R AR Z AR
;%Vm%A%&ﬁ%m@%%*&&ofA*&&%%&Kb&%
BHE #9IBAT B

KA A2 W T AR B S A B e B4 . AR L AR AR
LA A8 B 98I0 R R AT AN B A WA T 4k 450 W, gk X sk
LR Y7 BRI Z )5, S - M AU B H TR N 1 A% 3B AT 69 ) AR
8] o

HERE

ARFF B2 A TAE ) 09 A8 A AR TR e AT 42 38 52 R,
o =AU AL BN, TR —ANA LR, KAk 10%8 &2,
T3 A AR B E R GIE 5% ZARAEE KA A B, 3517 13 1A
T KA1 75 o

eEE

W, A W, 6 08 T B A£-0°C 3] +45°¢c(-32°F #|+113°F) . A2
WIEE A WA, TiRAMIF LRI A LRBRH. RIFHALLK
% & 0°c 3] 30°c(32°c %] 86°F) = 4],
B

E T bty TAE 6 IR TE R £-10°C 2]+5°C(-14°F 2]+122°F) =
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o A% IEE T TR A v dRdR, vk 0°c (32°F) VAT A=
J£ 45°c(113°F) A Loy iR Bk b &4 & T,

T8 IR A3 W N BRIEF A AL RO T A AR R A
w6, A BN T R 8RR . B R4 kAt /£-20°C AT TAE AL R
AR AZ LT AL /2 0°C AT & R KB o A4k A Al Fadd A 2 1],
PRF WL IR R T4 A8 I KR E R o

K4k A

AR IR T A A b, RA 2 2 B Ao AR, 4 3%
Fi£-40°C 5]+50°C(-40°F £ +122°F)iL B M. 2% AH LT 2
A iR BTG B R 2 Bk AR, BUR

K4k A

#£ 10°%] 30° ¢ (50°%] 86°F) % i & ) 64 377 42 W, 37T 4k 5 — 4
RIELR. EEMBATRGTEERLT AR Y, —F—REAABFHK
W, 7 b W R SRR e B T (3R3R)
1 ) 74

B A AR T R SR S RO, Hobk AR BAL AR 5 48 R A %
Bk A KkEn £, — 48w TH448 ) 2 4 R4 300 K Ak
W4 B e R BT IR 6 S AR, R AE G W AE R A 4R b F 4 K,
AP R

EIBPAE AT IE B A R ek W AR A R AG A K KRR, &
A W L F 4 2 3,

BEACFRERS

B TR AR S B A AR R R e RS G (R 44k
A

WAL T B
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FFANE R — NN E, BAL

W, dede T IR

1. RS ML LT T Wi, 7 & L F M 1-8 3L
2. e kag PUSH JF %o
3. BT AN R 2 eI,

Indicators | Activity Charge capacity

I Blinks 3 times At or below 10%

I Lights for & seconds 10 to 25%

I I Lights for 5 seconds 26 to 50%

I I I Lights for & seconds 5110 75%

I I I I Lights for & seconds 76 to 100%
4R B AT

LT BUR ok B TAR B, AR 542 P — Wk B AR,

BARA10% B TR TR T, WwRET 2R AFET 2460
RILEES SR

B M R IR (E X IR AE &) B TAE B, — NGk
AFRTREESAEZRER P,

M

IR E AT R WK E 8 — M fE & ERIPE L
M B 0 BB EG ke R AR I 8RS, R AR IR R
o AXRBRBRELEALFM 3-8 Ao
AT IF AT I, HAT T 5 4AE

1. it Start>Settings>Control Panel;
2. AT Wik E FE AR, 5K )5 i& Batteries 472,

W2, FAE 69 F) A48 0 (AT B AT 69 T35 wR) B 1] fe 3R
ERERS
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%) 4 Bt 1)

JE R E FE W ATIT N A R AT FER R T T T 4k 44k
AL A e ) L MU W6 i Ao A B 69 KBTI . SLAE B R R B AN Wik
(e €2 42) R AT AL I3 B R o H ] A AT B A ) A BT 69 3t
F AP R WA 69 — AP T3 i3 AT IR A el . AT R AT,
JE T FAEAT —FF &R F 4, do o i, N A P IR B AR B F,2 )
Z2FF— 4o

Bk
VAT ik 4

sk R % e 0°C(32°F) L F &, 45°¢(113°F) uA b 2 Wit 7 W, 48 i gbi8
O 4 Wi 7B T R AR Bk B BT A S B A s

3R A,
DHAEH —/NRE R %, B 5 WDUE L TAE K £ A B, E

RRALCHNEBLRLL L, ESNTUXIRE, —ANT AL LT
2 4 NI A R B( ), B 2 M AEEAT, & 8 NI T H i

o RAOMABCE T A ib, a2 e b b, A3
Fith, KRG B R Ak,

B4 2, 2 0 AT B 7 7 b, LS AT i A S 2 b JT 4,
A AR HNG WG, B 5| 5 = vkl T e B,

A ESET B ILEARR T LRIEL LW,
Bl AT I B LAY
1. FebaN gy, 2 LFM1-5 T

2. AW RS A WRIEL. @R AL THEEZLE, Rt
WL SBP TS AW

e
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ShER A,

TR ET M SR A B (5E FHEA M4 B2 ®),A T
7| Fr ik R 8,

1. REZMAA R LBEACER T,
2. Wb LB IS AL E,

—HR R MR T 3 IR o
AL

B G N CRIELR R F A WIRERE L35 Bhg Bk
Peik AW, RIS W v E L A H-FECANEEANR A
k4 k. %# Start>Settings>Control Panel>Power
Management>Batteries 42 &k # A wiu b9 L B foi K S o

KRI W R b WA, oA R T LA S A ST
R, 09 3547 B 18]

S E 8 A% IR 4, it Start>Settings>Control Panel>Power
Management>Batteries. Batteries #2 & % 7w €A F 13 & 49 F
BFAL 2] 3 W ag R IR S

L R AT T 2800, 3 AR A e e A A Ok AR
o BZR—RALA — /NI RERKRE— DI, FEFRA G L AE,
i — BRBT IR, 9% B R R R T AR B

P —NRECABALAEKRIAL, 4 —ELRTER
WRAT AL, LR ERRIEAC LS, FCLEREHLSHE10%
B, 0 TACKAR A Z Wl A R TR s — ANR T A I ¥ b 45 R Ak ik
] AAL R B 1]

BRI 89 IR A A48 Wbl A A RS 8] R AR RE,
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REBEHINZTALBKREWNBII TR, XRXEAHLINFHABRETH
HEBEAFTUBRRRAC—FT —FT ZROGRE . DAL BRI LE,
HTALFE T VATE SR B 69 K &

% .3 ¥p Power Management>Batteries 42 #9538 &, B B i% .3
A TR AR R T B R LR AT B R TR o AT AL 89 B AT BE )

shapi B

BRI X E T Bk i b 2 (5% F Mk A 32,
B—2 ),/ T 7 7 kA b — b i

1. BB N B0 AT
2. # Push 2| Recalibrate Left Battery Bay 4%

Fol B A, G B B KA R ) kAT R A
BokA. RBILAE 10 DR b TR SR GILH,
T g

A SRR
FIRER L VR CE AL T I 7 F KRR A Bk,

1. & Start>Settings>Control Panel>Power Management, 47 7

Batteries #712, 303 W 0 2 R AR IE (3R T &R IR) o

X A M ABLA B3R 7L W, o

B é X WRAEEXE R WRIERE TR, LF 4 )0t

A A 8 AR IR TT R 40 AU

37 77 Batteries Arig, it v A& A w(HA N LR F 1),

&% b4k, % Start>Settings>Control Panel>Power Mana-

gement>Power Saver, % jz it No Power Saver action.

BB A B B A, A i e 2 A (L 6 i),

8. HA—KRAEXNWRNKNER WRERE AT G, 254 Bt 1
DAL T XA RE

2R S

~
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9. # Start>Settings>Control Panel>Power Management, 47 7
Batteries 4772, 14 ©. 3 & T4 A W AL I o

S W IR T A T A R I, BT AT WA R B S, b —
R Je R, T Z B JBT o

ZHR(FR)RR L
HEE S XN BWBRARNKKS = WA THRELBEEZR

G FM1-8 WAe 1-7 W A5 Fo £ 3 w6948 KL
EIR EH R R AR 5 R B E E 6942 B0k, e Moltech type
NI2020, #:TFéj4e i FEAFE S L E. AN Vi B LA AL EfE
PG A KA Fo

AAEFT AL T RAEZATRE, 588 3-7 WA KW 53 LA
TA W RIGAE T W38 R TAE (4 Start>Settings>Control Panel>
Power Manage-ment>Power Saver>No Power Saver actions){# ¥,
MR AR B RGBT AR,

R

B EE LT R T NetTek 2 b ALad 1 3 b, it ik 4 T4k
JUdife R A LB A FARIER(FE) Bk 4

1. 7,3 L& X R Al A SRR IR, 45 7] &
o Hi—WFTEBE(ALARBAZERNRRSE),
o EZmE THRMEMRBERIE T
* %3 —& Xt HM.
o & Jfl— PC 3 LAshiL,
2. EE MG AT TAE 77 Xk S R EAT M 2 BF X AR

T (8) it
J2 B P A% b AE R — BCRT ) )&, R AL, e T HRAE

1. # Start>Settings>Control Panel
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2. ITHFBIRE FEE AR

i PowerSaver B #7(5).

4. RIANeut, k5L —BA RT3
o B AE (AR R IBAT RL LN F)
* XFHAFEFEA
LI O A N i

5. fE 91 @ k4t @ nt, ik Use PowerSaver on External power i& 47 ¥ %
%o

6. & w15 4787, Minutes of idle time until PowerSaver 3z 1 T 4%
FAX AR TAE BT

7. i OK kA& T S BH X 2,9 3] L7 1% 2o

w

AR RAE TR G, T €8 A IR B EAT, BRI AR
b fih B B4 75

R T LTS L RTEIEY LS T LRy
CAATIRE. A @R RIRIF A AT R R EEAT AT
’]"Tﬁ‘/)\/gi/%o

* A E AL
* W K AR R 69K He e T B

1. i Start>Settings>Control Panel
2. IRk E A
3. AL I E AR
4. {FE R RS HH:
o AR THMAFFALEFT LA GRS, ARFT 2
(AT )40 ) R P AL BAT BRAF B9 AR 3, BT A A 69 4
e AR HE X M o
° FIAREIIELBN T Ko R UMW S LA A BT
BRAF R FAL IS LA AN E R E T 24T,
E R T BT AR AR e 89 T % % K NetTek 2 M- & g2
SERp A AL RA5 6 ) R IBAT BT A9 B4k S N R K4k
o BTGB At Ao AW B — k) Fop R, ELERA L
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H, R BRI ok AL A R AT BB AT R — A

L
Holy B — R F o B QYR AR E, TR A
X pf. XMAEHEF, TR T:

1. i Start>Setting>Control Panel

2. IIFF A F AT

3. i Sounds #rit

4. X EAT R 9 5 & F A4

5. 4o %, Volume #7ie F) i 45 3 i 3k R RV &% o

T WAk R

NetTek 5 #4L-F & & A SDRAM #= k14 ROM % % # CPU 5
BAE R R NIRE R F & XFAREL R A8 BANTDE K 3
1 ‘1:' o

& 3-1:NetTek 5 HBL-F & At 25 7R

Memory Capacity Memory Notes
Location Description
05 Flash 32 MB Read only Hosts operating system.
(RO
SORAM 32 MB Readfwrite 16 ME program, 16 M file
{RAN2 system memory. To adjust
the memory aliocation,

select Start - Seftings -
Control Panel > System
and open the Memory tab.

\BudtinDisk | & MB Readfwrite Select Start » Programs »
Windows Explorer to
access the file system.

\Floppy- 14 MB Readfwrite,
Disk diskette

\Storage User purchase | Readfwrite

Card (PC card)?
\Storage User purchase | Readfwrite
Card2 {PC card)?
AiE | BE Ak e | &iE

34 90
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e A 32MB w5 | EREAR
SDRAM | 32MB /5 16MB #2 /-, 16MB X+ & 4 5-4% % -
RAM A T B A B9 F i Start>
Setting>Control Panel>System [ #f
I
I Ak 35 B9 AR
NEH | 8VB x5 1 START>Programs>Windows
%A 1.4MB i/ B # | Explorer @t N X & %o
#*
BHEF | PME 5
PC
BT | RPME 5
PC

1. % kAHE
2. HhkHME
3. ®H, LT M B-3 !

VER &y

KR T e — k&

1. AT FESHAEM GG HFENTT, LA 3-1,

2. BT TR R T,

2 :NetTek 2 AU R F 4 & 6944 XAk, 4o ¥y £ 69 3.5 3£,1.44MB 3
% TRAE KA A & A A PC AL A& XA dd
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Aocess door

3. i# Start>Programs>Start Floppy Drive

4. # Start>Programs>Windows Explorer

5. R+ Floppy Disk sCAF & sk i N A Fe i B 49 Ak & o

6. 1B AR A 4% E IR B 5 TR 69 4240 o

7. ZRIGAA —REREHNZFEAARE, THE EE S E 2583,
%% PCF

1% 8 2 A~ PCMCIA TI# 3% 2 4% 5 45 PC £ S 2L F %
Heo (BILFHEB-2 8 itk if38)

FlashDisk :3% e 47 5k 4% 25 2] NetTek 9B X4+ & %o
Ethernet F: 3% B33 M 5 VL KW &4,
Modem 2 5. 3% 5 £ 4% 3| &L 3% £ Mo

[ ]
iz T FAE— PC 37 % 415 R A M NetTek 2414 F&, &A%
BRI & KR P

3T 919 Bedo 4 PC

1. 4244 PC Fa7i i L1 L)

2. ATANHTRA M HATT. LA 32,

3. % PC 474 @ 4 S AT ALE 7 4o B B 7 45 F 7 A NetTek -4t
e
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4. B LB R FEBEEN.
5. FFBh,F TR 4

EBIA A WHRH AT R K 0 B 3-2 BT, ARG ARR
L 3boh, A A AR R F B, R4k R 4 PC Fo

Install the Ethemet card
in this slot. Do not
nstall any other card in
the remaining sl

Label side

Access door

/| 3-2: % — PC +

EINE R B R AR — ARG E 1 APC FRABEA RS
PCMCIA 35 2 1,3 % —/~F Asmno 2

FNP A F & SRAM A4 252t N PC  F4k &5, 284740 T H4F:

1.it 4% Start>Programs>Windows Explorer.
2.3 Storage Card i+ &,
3. 37T F &5 PC F X4k ko s

LohREME

KRR B 8 4r b 2%, 5% O B3R A A B Sl 3 4h 49 NetTek
O WAL K E 0 X 25 B3] — 15 IrDA 3k 2069 47 67 AL
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K% —X# Z 5 — NetTek 54X

H K% — A E 5B — NetTek 5 WAL, #474e T 4E4E:

1

8.
9.
10.

11.

TR WAL 3 — KA 5 A | 3-3 BT

1

Q
H | /fl Port doors

T

A 3-3:3 x 4sh Az 3 1

[ | CEE—

T HAS AT A 5% 2 (L R AIT) LA 3-3;
6191 & A7 17 AE E A T Ak LB A4 4 9P b R 89 3542
o 3-3 r L KBl e, 2 ass e £ X F Sam T 1 R
Z ]9,
1% Start>Programs>Windows Explorer.
AL I I AR T B R 3E A
TR 3-23 T _E ik 69 A i NetTek oAUk — S 69 4 35 1
5 2,
JE & % 5L kit File>Send To>Infrared Recipient.
FE3 M AL E i File>Receive (3 3-23 T Frik ¥ 3% 3).
BRFZDWA SR IR FE st I(FRS —5E
K% F].)e
KRR B| 2 1E &0 AFAE B A N IR T K, E A AL — AN RE A
AT A b s v, 2K 5 BR(i2 File>Send To>Infrared
Recipient),
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12. BB & 55, 2T TFHEGTEES I

& el fike e DeekEaniurebog o)
FR oo 2370 bietes

M7 — NetTek oA & 40— A4

g A — NetTek 5 ABLag A, dm T #4F:

1. 3 3-21 W LAk RiZ — X2 5 — NetTek AL #ATH 1 £
5

2. AT T — XA kARG LA

3. it # File>Receive,

4, FAFUIEIMBERTEE BRI TR EALZGEE...

5. & XM T EE XA S A NI &k, EH AL — A KA A5 AL
1F LT 98 55 0 R, — B 4%, R S B X (it File>Receive),

6. ZBfEHE LG, —MEMT ETEE L I

. } Reerrg Ak (Faibrebog o)
3

Clastnatan dwastass D amnpl)

i)

K% &ML E 3] IrDA Fre4

FE W7 K 25 R 3] — IrDA St R 69 3T Ep AL, AT e T AR
1. Wie T 3@ () 9L B) k& E 376 Mo

2. BLEATH AR M LI & B2 5

3. ¥ NetTek 4 #7342 47 p AL 4 .

4. FTFFHHALTA R GG 58 2 17 (AR L B 17), LA 3-3,
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5. ®sh & &7 17 AL JL R T FLIT 4o b SR A AU o 89 B &L R E
1%

6. XM T H 3-3 494 7,4 NetTek 5 M AL-F & L9 2odh & 55 0 Fedy
PP B 2 AT

7. %% Start>Programs>Tektronix Utilities>Diagnostics.

8. 47JF Failure Log 1+ 4%

9. it #% Print Log.

10, AITHEE M ANE SITH A B RA TP IAEZ % T, R
iz OK,

1. F— A RxE & b I, 3 5 W AUFe/ AT P ALK T 479 A 409
3%, 2K )G Bk

Print oK
Prirer: PLL Laser | (Print Range oy ez iy ———
r ] | &
e 8L O Langscepe

[emer =] [Marains finches) —————
Paper Sigm: |Lether -
¥ Dt Mo S il

ek mant [ Botawe [T

RRUSRBREGEZFA:

do RARAE R B A AR 345 818 3| 98, X M de T 4RAE:

o EAvirdhin a4k Hox— A &KL LM FEA Sem Fe 1 R (KT
5cm F 1K),

o AR LLShin 1 Z A AT

o PEFAAXBAAA LIV LA TFHOIN&KBEZ, FHAT
P, ARG IR NG B A 3] FAb A B T X347

E B — 3% FE AL

A B BB e I B A AR L AR NetTek 5 AL-F- & Fo—iZ 35
WA R IR

PC ¢y &K
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1 | — & # 4 CD-ROM IR #) #=4LF 95,98 3, NT4.0 #:4F £ %4
87 & Xt FH .

HHELSHALE — PC

1. ¥ 9 4 RS-232 Mt a9 A7 A2 w4069 — 3w i3 3] PC 49 & Jkop o
(COM), A IARGG+ FHA %36 2 AL B 69 A4

2. WHh 7 —s35E4E3) NetTek - 4rALag $ Bksn o, AL 2-3 7 5%
243,

42 PC i b2 % s % Windows CE Ak 43k 4

1. ¥#% Windows CE CD-ROM 2 & 24+ (5 2474 — R .48 ) 3 A
PC #.49 CD-ROM 3z 3,

2. ¥ AR, %E KT, % Start>Run., & Open 3£, 3%
d:/setup,d Bp % 1 ¢9 CD-ROM 383

3. # 3k Windows CE R4 5% £ 3L PC 2@ L, kS B I B335
o

4. SR A EH B N5 MANIE L, — MBI B AR E LA PC
Ly 2 m b, X R R

iz 2% % Windows CE R -2k Z AT, 44 40 2% & Windows iZ 55 i
NIR G- AT AT 8 & BuE AR T o o 2K =R
RS- LA B e B I A

7= NetTek 9 #740#f= PC Lz o) 2 5 ik 3%

1. & PC 444 ¥, & CE R4 B 4F;
2. 7= NetTek 5 #4L Lk, & Start>Programs>Comminication>PC Link

IRTRE ZE LY B2 Ao e B EB X5 & F 35 JLR Rriry R 72 %

AR ARET BT AT A L6 %38 R ATiE &

3. £ PC 2 & L, 3k Start [z & 5 348 7o

4. 34 8 NT 345 & 4269 PC 4, % 2 5 i, /2 NetTek 5 2 & L
WNARE A P&, BER(BL R E &) A & Return
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REbEXA

1. /& PC £ % New Mobile Device Detected *}4& &+ &
Synchronize,

2. /& New Partnership Wized #f3% & ¥ & Next.

3. # &3 [ ¥4k Ak Manual, 8k )5 3E Next,

4. 12 Type ,7F B ArA Bl 4k el 4.

5. 3t & Finish,

Ei B EEE T, CE RS 4 BHARKR A M AT EAUE S 4
PHEIA. LREFERE, HEHAFEILEPCHMESEA,

6. # NetTek M DLAT @ A IR IF £ 15 8AF -2 E S kG488 P&
BHiEERE
7. Bk AE AU & A 8 IR T £ kIR iE AT

AR 2 ¥ Windows CE IR 53k E /£ 1k 89 PC LA, TR IR A
B AL e I B A B, B T A% ) T 2R A kA2 dE N NetTek 474X

—

. AR O 4 RS-232 w40 M 449 — 35 2] PC #Lég & 3x(COM) 35 =,
B IAR 83 AL 5% 0 AL A K69 o
2. #AE WY B — K3 NetTek 5 M $ Fom v, £ 2-3 WA X345
=3 A
3. /& NetTek 4 #4L L, & Start>Programs>Comminications> PC
Link.
4. 7 NetTek oA 2@ (X T NT) ARG P L fe B, R )e
%4 Return(i& =),

REF

B AR P AR I8 B B, XA e T R R

www.tek.com.cn 52



YBT350C NetTek 54X -F &

o Atk PC #Lf= NetTek o #rAUk A48 B K 45 % . 19200 & 7518 A

B AF R, AREHFF AT AT E AL LA AT ik A9 K 4

o 7 PC1x4-# + & CE R 4B 47,41 iA £ Communications 4712

(%) ¥, 4 % Hom v 3%, Enabled 2 & Device Connections # 4 it
o
%Rz 4769 Windows NT 54k e93 B 23 Lk &G %
KW, %% Windows NT R 4281+ 4.0;2% )5 A3 % % 3 Windows
CE MR 43¢ 2 81 o

&I‘Pa =] ﬁ"ﬂ-ﬂﬂ(#

W T A4 69 4] NetTek 54 BL-F & R X HH 7185 -
ARG (N R)3E S, AR L i 4742 4 CD-ROM T — 47 69 8
1k & %o

CD-ROM @, & T | #:4F & 4

FiEIHFER. ERIES,

/i“lf‘ i%/i_.‘l\: i

BB A FIERIET,

BT 5 L FHILT 5T,

B RAE IHFERAETS;

NETEIBFENHTES,
Hi5 X4 B KR5S,

HEE X HHEIETS,

b E R P RET

ZREAF

1% B T 7 AR89 PC ALE T & —34F 2 I Bt

7] NetTek 4474 E.

1. # & Y350C #= Y350MNetTek 5 #8L-F & & 5 i+ &3 24 CD-

ROM.,

www.tek.com.cn 53



YBT350C NetTek 54X -F &

2. Z1re%#% 7 Windows CE Ak 4% 4#+(3-27 7,42 PC #L L2 K 3k
Windows CE JR %-#c1), 5276 T 3] ¥ a #| e, .k PC du L9 & 3%
EE
a. &4 PChES42 M09 CE RS B A7,

b. #t Communication.

c. &£ Windows CE JR 44§14 214 & /M 47 7F Communication 47
1o

d. i@ 3T & B8 O IR B 4, F S Enable #4] £&(Enable #
R R AN &L R AR, )

3. J5 CD-ROM # A\ PC #t_E 49 CD-ROM 2x 3,

4, ¥ A2 )5 A& 8,48 A Windows Explorer(My NetTek) iz 4%
.47 7F CD-ROM,

5. M EBA A LS NR T B& 30 BT

SR B A8 A (48 ), B FE T 20 94F ko

7. T LR G244 B R0 AR (A SRR IR AERE S
A, # Enable & 4 3% 7 i£45),

o

BURBE SR 1E S X &

E1W T A EIRA NetTek 2 A ALF & — R R LHF— M2 5 8AE
RARYG%AET

BUEAE T LA L 35— 2 NetTek 5 W AL-F & & XL #6935 5 &t
HILBAEAL S P F WA K3ET LA 5o
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i A
M ALBLARALAE
3R 52 9 NetTek 2 A-F & & A SR fep A PT
B HAEARAARIE, R AEAR A AT A 9 B IAEFA IR A A R
ARIEAR

wAAFMI AR A—T AL EA—4 AR A—4 SR A ZRIT A L
A F NetTek 2 AL-F & #9424k o

&A1 AR
Characteristic Description
Battery
Technology Lislan, SMBus imerface?
Vinkage 10.3VDC
Capacity? 5000 mA
Operational Life, typical 4 hrs?
Charge Time, nomnal? Instrument shutdowr: 4 frs
Instrument operating: & hrs
Life Expectancy 300 charge-discharge cycless
External DC Input
Vokage 24 VDT £15%, 60 W maximum
1. 5 SBDS1.0 & A%k %o
2. £ 0°C AT 252 £-10°C A A BE KLY A 75%,
3. & HF KM AL BT E
4. i3 36 £ 0°C = 45°C 2 £ AM LR A,
5. i@, 42 300 K F w5, 40 XA RRIFR K49 80%.

* A-2: 2R

Characteristic Description
LCD Display
Monochrome Size: 9.4.in (238 mm), ransmissive
Resolution: 540 x 480
Color Size: 1004 in {265 mm), transmissive
Resolution: 640 x 480
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F ASHAL ik o

Characteristic Description
Paralel Paort
Connector DE25 female
Mode Centronics
R5-232 Pont
Connector DES male
Baud Rate® =115.2 kbytels
Keyboard
Connector DIN miniature, P5-2 compatible
Infrared (IK) Port?
Baud Rate =115.2 kbytes
Headphone Jack®®
Connector 3.5 mm (Vg in) diameter
Churtpust 30 mW inko 32 0 inominal) at 0.2% distortion

Microphone Jack®

Connector 3.5 mm {Vg in) diameter
Sensiivity 10t0 200 mpp
Bias Supphy1® 1.5 W, 620 i

K ABHA LS Hir 4 0 (%)
Characteristic Description
PCMCIA Port
Number of Ports Two Type Il or one Type I

Floppy Disk Drive™

1.4 ME, PC-compatible

DC Input Jack

Connector 2.5 mm diameter, center conductar postive
Instrument Module Interface (SP| Port)
Comnector Proprictary interface, 80-pin blind mate.

6
7
8
9
1
1

* A-4 R4

EIA/TIA-574 5qF %) B4z 4 & — %89 DTE & o,
5 IrDA 474 1.0 J K Jx %o
HIEGEN B P EFER KR

5 Labtec C-322 & # X F-#Li &
0. B2 2kQiE & M AL, ARE
1. RIFHRAEE XK.
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Random Vibration

Operating, typical

Sustains 0,31 Qe vibration from 5 he to 500 hz,
10 min duration on each axis.

MNonoperating, typical

Meets Mil-PRF-28B00F (24 June 96), Class 2.
0.03 g° hz from 10 hz to 500 hz.

Characteristic

Description

Temperature Range!?

Operating ™4

~10t0 +50= C {+14 to +122. F)

MNonoperating

=40 to +60- C (-40to +140_ F)

Floppy Disk Installed

Operating: +10t0 +50= C (+50 to +122= F)
Monoperating: <20 to +60. C (-4 to +140. F)

Humidity, analyzer platform onby

Operating

5 to 95% RH, noncondensing: +23 to +50= C
(4734 t0 +122< F)

Nonoperating

5 to 95% RH, noncondensing: +23 to +60= C
(4734 10 +140< F)

Floppy Disk Installed

Olperating 20 to 80¢k RH, noncondensing: =28 C
(=B42_F)
Monoperating 20 to 80¢k RH, noncondensing: = 40 C
(=104 F)
Altitude
Operating 4,600 m (15,000 f)
Nonoperating 12,200 mi (50,000 ft)
Mechanical Shock
Operating, typical Sustains half-sine mechanical shock, 50 g with

11 ms duration. Three drops on each face for a
total of 18 shocks.
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F A-AIR A (4)

i BLEA

Free-Fall Drop A w2 %

TAE RS JE 3R 3K %5 R, © B R & )G, TR
FA35. M 107cm(42in) & B sk
JE BRR TR 69 R

K R

T4kt JE 30k PR AR 558 A\ A ARG AEAT — &

BRI . M 76cm(30in) &
J Sk — BRR, TR 6 R

B 7K Bt A& S 0 R AFM T T Bk
e 5, A S R B AR T A R
BT BRAE 1 A E o

12, XA ZE PR NetTek 5 ALF & -

13. BAERSE P RALEKRE

14, &7 0°C(32°F) F w2 F&4k; £-10°C(+14°F) A s & K 4 A
75%.

15, @RARZHEN.

16.  BIRFH AT RIT L™ @ 5 50F KIEN R T REAR IR = Foo

A5 5w 5 5

% H A R
DE &4 4 & i# A % W gk 2 89/336/EEC 354749 M 5o 4F
EMC ) BB BUR A & 89 T 5B ARG AT

EN 61326:EMC & & A B89 & A.3%
&R TN Z. =5 FR 5

IEC 61000-4-2: 3% w538 W, (AT 47
/& B)

IEC 61000-4-3: 3¢ ¥ 5% 3 (AT A7 A2
A

IE)C 61000-4-4: 57 B ik ¥, B; T/ Bk oF
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(#4773 B)
IEC 61000-4-5:4% % 7 4 % i (447

#+ 4 B)
|IEC 61000-4-6:4% RF # % (347474
A)

IEC 61000-4-11:47% ¥, /& 3 [ o o 1
(#ATH= 4 B)
EN 61000-3-2: % i% W, A 3% ok 48 4%

BRXAL/H /L | HFET I AL i@ *69 EMC L E:
EM4F4 EMC AS/NZS 2064.1/2 T 1, H5 F= & 77 % %:1992

FCC $24 /2 FCC 47 CFR, % 15 #:4~,B -3,
A B ZTEE N

# A-5: 52 5 o#(%)

Gl A1 A2 B

S A EN 61010-1:1993

AT 2,35 ] A S B B AR R A R AR &0 & A& R
UL3111-1

W A F Fe ] XK S AR

ANS/ISA S82.02.01:1999

W, e i F X, W 2L AR Aol KR A K B AT
IEC61010-1

BT F 358 e X I B ARG IR I B 2 & Ko

i AR

TR R AT o N Fe 0w B BT R F . BE S
8 MR Ae ISP IR Z R 4 8 = oo RAA T HA48 X371
¥

TR R

TG RIATF IR, AT R R T BN ERREY
89 TR % 5D T v 5 3T 09 A TN A A

TRE 2 A

WBFAUH FIRAAE F6975 75 £ AR RAELZH KR G T 5
Rl R AT, IR TET LINE/REIEIE,
B 69 B LA 7 oh R R B A

74 E 3 A
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57 R, TR, A 55 TR F A THLE., Xk
B G B BT i AR W TR A X G BT R % fE b
H AT, @ AT R o

TR E 4 R

TR AEFEGEFHBEIEFHORE,FRE,
BT PN

P
i
\\*_W

1SN
—&

A5 S

R
bt
T

& 47 14110 5]+50°C(+14 £]+122°F)

% | Bd | 4
e AR | | |

KA UURE
S ¥ % Jr 3 4 (% & IEC 61010-1)

17, 3RS fo IR 2R 50 69 3045 T K B T NetTek 2 AL+ 5 o

55+

AR AL S A K R BTIRAE (FBT) 3R 2o

18. MM AT A 4G5 T AL 7~ AR &5 RXY £ 0
19. A4y EMC 470 RABAE A A 677 5o & K69 Sl 4L,

& A-6: AT

Characteristic Description

Dimensions Height: 23 cm (9.75 in)
Width: 33 cm (13 in}
Depth: 8 cm (2.5 in)

Weight20 One battery installed: 4.23 kg (9.2 |bs)
Two batteries installed: 4.82 kg (10.2 |bs)

20. aFERFAFT. T LIEEE I KM,
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% B

X355 NetTek 5 WAL -F & 45 4 Fn i 4F R AT R AAF

A3 A

# B-1 21| b 5 & NetTek - A AU A2 49 I 44

Cuantity Part number Description

Tea 012-1379-00 Cable, R5-232

Tea 016177500 Soft case

Tea (016-1882-00 Screen-Protector Sheet

Tea 119-6029-00 Desktop power supply, AC - D univer-
sal, 100 - 240 VAC to 24 VDC

Tea 19610700 Stylus

Tea 146-0127-00 Battery, Li-lon 10.8 VO

Tea 161-0310-00 Power cord, US 115 VAC

Tea 071-0805-01 User mamual, English. Includes CD-
ROM, ¥Y350C and Y350M NetTek
Anatyzer Platform Language and
Instaliation Software.

Tea 34B-1661-00 Titt stand

Tea 367-0518-00 Shoulder strap

&4

& B-2 3] TART ¥ % 49 NetTek o #ilit k. A & ITH1E &
ThH R AR H AR HA X WA RIKAR T KXo
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Part number Description

116-0095-00 GPS locator

116-0896-00 Flash RO, 128 MB

116-0987-00 PCMCIA modem card?

116-0998-00 PCMCIA Ethernet card, low power
16-099%-00 Printer, PCL paralel

016188200 Screen-Protector Sheet, package of 5
T18-9402-00 Reyboard, miniature

119-6023-00 Adapter, n-vehiche power
T9-6030-00 Battery charger, external two pocket
146-0127-00 Battery, additional, Li-lon 10.8 VDC
016-1866-00 Hard case, metal attache, single module
016-1869-00 Hard case, metal trunk, multiple module
161-0311-00 Power cord, Ewope 230 VAC
161-0312-00 Power cord, United Kingdom 240 VAC
161-0313-00 Power cord, Australia 240 VAC
161-0314-00 Pawer cord, Swiss 220 VAC
161-0315-00 Power cord, Japan 110 VAC
161-0318-00 Power cord, China 250 VAC
071-0806-00 User manual, Chinese

071-0807-00 User manwsal, Spanish

071-0806-00 User manual, French

# B-2:i (%)

Part number Description

(071-0803-00 User manual, German
071-0810-00 User manual, italian

071-0811-00 User manual, Japanese
071-0812-00 User manual, Korean

071-0813-00 User manual, Brazilian Poruguese
343-1610-00 Strand hook

H W G A 6 AR R BAGE AT S AR ik
WRPTREAG TR R BRT R AL Z B, AL BiE R EEZ T,
#2008 9 A 8 44 o (B L 9A) o

R A4

# B-3 3| 7T AR R A H L K4 NetTek 54 -F & Loy
B, HEITRIZEEFEEEERDPEISHERIEZ, B IX
A £IEARE F Ko
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%k B-3: 9t 444

Part number Description
(020-2364-00 Floppy drive upgrade

Mk C: 437

AT REERE LT AT I A E(ZA):
o R FRAY R
o,%

ZREFARY R

B ik 38 B X KA, BT AT R m AL B — B RARI R
R A4 AR NS W FE, AT B-2 Wk 3048 =3/ 5o

%% IR R

1. ABREARNRYG —2BL. FZRANEEIL,CHLITL
87 69 22 A X047 o
2. F k27 Hkm ey IR £

BRI

1. E/%A%%J}FH%TE:V FE—13mm(1/2 & 1) 5, A7 @3 &, % %
J‘}}La 3tz ;’ék/]\g;/uo

’]TH?:%%\‘%L_ 5 k32 B TSR AT S JLE C-1,

}ﬂ’}a}}-% g2 ’tk/l\}?f-/uo

BT 16) F) 42| 469 PR AP B

1% RAZ )R89 0 KR T 6 T AN G RTHE A, i T R
5] v 32 A o

LB R TR BB R 1A U BB B, RE L

@P@N
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Peel away and fold back 1o
expose the top edge of the
sereen-protecior sheet

C-11% K 5 R IR

32|

~¢/
o)
a

T B T G K8 SR AR L Bk i, b 4 AR
B N RAL S ARAE R 69 A

1. XM P& NetTek 5 #8954 BFad i ],
2. %% NetTek 2 MM SAL E B 5 69 8 K11, A E MR H 1-
11 IR0 0 XL Rt A B
3. A3 ZRABKAEFENRABENZRTORA RFENE,
EIA GRS AR, B LAL R SRE. K. TR, ZFRRE
WA F EH] 30 71 R iR 8 REKBER FiE.

B AL

BB R e T ERE LA E LR QEHA N
B e (Frof M AF)

1. B WA S RN, Br ks fr 2 i Ko
2. B MBI 69 J IR AR
3. AR EF T I
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4. % b4 F I d= L4

A (i 4)

1. A AR B A, B b3S i o Rk
2. A AU 0030 o

3. % L4 F 5 4o L4

EWA AR

Jo R T 48, ¥ NetTek 5 M AL-F & 12 453 0t AT A R K
o HZREOEHMAERRTERAERN,THEEQEHMRET 5] Bt
BB AR

1. | — WX 5&ER VT 80 (175 7F) 69 484848 o

2. AR UHRY RIS A& k.

3. ENER B AR YT IET RO EI @RI T 8BRS &R A #
KA A A A

4. FEHR W R I dT SAUE 3 4KA o

M & D:i5 7 | 9K
AN T AF R A T3 NetTek 5 WAL & 2 ik 2 & EF o
A B &2 A, ¥ AR AEAT B 1) B AT AT 4717 ) K

1. # 4% Start>Programs>Tektronix Utilities>Diagnostics.
2. ATIFL Wi ATIT
3. WUEM XA, AR PTAAS B R R AT &LE + R UG AlE - & Al e
+. B ILHE D-1,
4. BB BIFBATHIR MK HRAEMTR B ZGNKEE S,
5. BHFET FIMKXLERZ —:
o IR LT ATk kA (48 2) T A KA R R
o H F| kW IEATIAFAG M X A B KM (B &~ A R P
ik
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o LI B EAT R BAGM K A B A P B4Rk
6. #t# Run FF45 MK,

Z:dm 2 NetTek 5444 & IS 3K k3%, 35 5 & 5 45 P s
IR AR, R IBUR KA TR, AR A LM iX A8 £ AN 2

Extended Diagoostics
Diagreetics |Faikra Lo | Poser-On Seir-Tests |

Test Naime Last Rersult  Fail Court Q Siopped. .

Blatform et
[]*verticsl Lina Tast ®ioop [1 z

[ Horzortal Line Test ekl Fail

[ cokor Parga Tast Cceerutia | T Cla
[ erghirees Test

TLED Tast

[ Towsh Sereen Test

{ ) kapbaard Test

[ pccia Sioct Test

[ rcrcta siokz Test

[ =erial Foet Test

[ Peraliel Fort Test

[l 1roe part: Teat

E]

T AT T
B D-1:NetTek 5 #4L-F & #-17 Ml X
Bk R

BT 1 G4 oA A BUR FIRA AN K4 R
ok 4 AL

LRERAZINE T AR KB L R ARB LRSS
[ mow Fort Test
e ()

W i

K FAZ 5 8 ] X KB AL 89 R B
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[ pomcis Siot2 Test

] Serial Pork Test Fail 1
[ Parslial Port Test O
PEEIR T HOR

R RER W R DR O &

Lliq.'l':l:l.l@
KWL F

AT R K X 69 28 7,47 IF Failure Log AR5t I i 7H &4,
A ATER kMAE F 89 A A, ik Print Log. #r A& % 693760 AT
IRA TP LA FT EP 2T &N 693845 3% 2, R B it 45 OK,

Print =
vt [Pilisma  x] Print Range Orientation

A ——lLl .
Wetpatw [ () gekection S Langeaps

Paper Sige;  [Letier | (Margins {inches)
[+] Diraft Mo Lafi L o [
ook mint i Bottom: |

S 47T K 2k MBS A AT EF ) 54k B o s K AT AL B, AL 3-24
FROEE S

R X5

SN0 RAREE S XY ALE S LW LIPS E F ¥
WX VLA 3 A 48 o

XF P B T8 B ) 4K
MR — 4 Fed BAR B (5w &) kP kv B 6 5 &,
EAATEERT

1. EBE XA T E P RFE R — o
2. R A RS LR it K kad it
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WO e R P ROR S NGB Y RAE e B, AR A R B KRR A
AT FTAE KT TP o

& B Z K

R FRT B E AL
1. FREM LR E KA — 5.
2. Bt E R L RFEL

NP AR AR AL AR e AR 4 RO KA A
BT AR RMIL T F o

R L 3K

MM & B3P B30 89 KT 4
i, %ﬁ%ﬁﬁﬁ%kﬁ%*%ﬁﬁo
2. RAEEL R TE

B TR PR R e NGB AL RGE el B AR 4 K] X A
AT T A K MAT T o

A AL E
MR ) AR R 698 & KA T .

AR T e 2T

T ABL,SAGEF T LR, &, e
55 An R — B,

2. B 2, 5 WE AT &% EFF(L. % 2)H,FRYER
— B (R MR ) o

3. Hitmat, mEBLRF B

B, F & & 69 IR,

—3&

R B R PR NGB At/ RaE ey B AR A R MO SX 3E A
WAL A KWL R T o

F M X,
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L2 AT, MR — AN AR E BH AT
ERATEERLT

1. EHANF %%L?ﬁiﬁ%éﬁfi o
2. Lt R A R R

2 8Om R PR NGB A KB R B AR A SR G KR AR
TR KMIT TR T o

Je MR T ARG, B B/ 2] AT 69 5T o

LED 4%,

MR FT & A b LED & 7% & 453,

1. FREE I TILE £- f, SRA -3/ 782: NI
2. LB Tat REE T R RE

0 P ROR F AT B A i NG i/ R e AR &
2 W BT, — ok e M) X 3k AR IT AR RIS .

EL D URE

B

MRLX KR S by 5Eb B E A TSR, A AR, A 3R Fe
J& AR AT ) 7 o

CEE RS SR ORI DT RN R

}E/i‘l”—%)uliéﬁ Hj‘,é] ]’\]{R/)\/ﬁ" 1&70)7&(‘ m'];}g» = 3\,3\0
BRI E R P AE R SRR PR R RSN K IR Bk, ) R AE
SCIRER L ST R ST

(%K) 4% & w4

# % %1% %) NetTek o a9 4k & w4l e & AN T fe .
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E XK K E A — AN A PS/2 4 4

1. &3 R HERIMYE PS/2 katist s dsta, £42- 3
WA K% AL E 6 A A

2. 4% Keyboard Test(4 &M X); & & 24 Run(i&47).

3. L mhat, R4 LM ONE B89 UK RS s 4E Ok,

IR B 3R P AR PRI & AR A ORI XA Ay R

o

PCMCIA #54& 1 @ :X(PCMCIA: M A &5 A4 35 F B R &)

A5 1 R,%% PCMCIA ix4 J%g%?g %35 5] — e 17 3 SRAM
Fo MRAE A ARAEE) APl Sy ft, 2K B L& 4 — K% 8 3 5 3 S,
B 4% SPE 5F B IR A A

EZ MK E Z— PC B = SRAM A4+

1. f24t%& PCMCIA F 364 & 404 — 19 3, SRAM £, £% 3-20
L uteR,
2.4 # PCMCIA Slot 1 Test; % /& i& Run.

L8 B B, R AL, N Sk M X A AT A kT
EF o

PCMCIA 354 2 @] +X

3518 2 F,4F PCMCIA 324 £ & & £ 4:2) — k1A 3 SRAM
To ARE B AAFAE AP Z) 687 £ — R, $5 5 S B, B U
F A% B E A 3o

EIW K E 2% = A PC B A % SRAM #4% F

1. &%/~ PCMCIA F 351§ N %23 — P13 % SRAM . &% 3-20
Lyt
i
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2. ## PCMCIA Slot 2 Test; % /& it Run.,

B R A B, KRR R A, ) R M 9K R AR T AR K KTE
EKFo

EIR AR & R ARG, AR A6 F — A PC T H0A T
% PCMCIA 34 @ 1,48 46 A 89 5 —AF AN R A 4 3 2

& 47 5% v ;] K,

Bt E 4 4 ) KA R B R A BB AR B A,
) i A BB 2 AT K) R B R S5k 045 5 A

E X E Z— A2 i) DB-OF $ AT £ K .

& D-1 B 730 = ik 3% 35 09 4T 46

Connect pin To pin
1(DCO) 4{DTR)
6 (DSR)

2 (RX) 3T
5 (SGND) NC
B(CTS) T(RTS)
8 (Rl

1. = 2409 DB-9 sr w545 28 RS-232 #4735, £2F2—-3 7
HFEsHaiLE
2.i¢ #% Serial Port Test; %k )5 it # Run,

LB o B, 35 B e 35 R A, T X S MR IT R R
WL FF o

FAT 3% v W X

B NIRRT RBE RS &, A & AT A%
23,9 R I IIE VoA - AE A R

# D-2: 54T IR W i 4 B AT 46
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Connect pin To pin

1 N

2 (D0} 11 (Busy#)
& (D4}

3D 12 (Paper End)
7(D8)

4({DZ) 13 (Select)
8 (DE)

3 (D3) 15 (Errord)
207

10 NC

14

16 through 25

1. AT 0 Lok

-

xi#’\ Parallel Port Test; %k & £ #% Run,

L AT, 35 IR W i 3 R

kML TP,

IrDA 355 @ @l X

. JE

B

2469 DB-25M 3R e i 4 5%, A K 2-3 T ik 2%

] — AN 2k W 84 ] 9K FEAR T T A

7 NetTek 5 A — 5145 IrDA F7ép i ja) 14E IrDA @43,

E 37 X E 2 — IrDA 3T A,

1. Ak, A5 321 AHASEA R,
2. ##FRun, LE&EEA P

SPI @)X

AR BN R G RGO R e 5 X A% KA
R E R FABRIRF BT ISR BB Fe ) A o

TEEER P & Run,

SMBus 2]+,

IE AL FE B Aedh R M AT B X ) AgiEAE
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L FHEHEM P %4 Run,
P AR 2 L] 4K

¥ &35/ 5 ) e Fe b I3 A R SRR T . XA AR AP
Iy it R A — M, B e £ BN S, ) 3k SO T AR RGBT A
% &R P 245 Run,

R A X

B & RERAT A9 B R AILA D-3 A X & EMIRAL.
AR IR AR

& D-3:i] X ¥ & Fo AR FRAL

\oltage (VDC) Limits (VDC)

+34 + .34 (mstrument module)
+13 + 1.3 (mstrument modude)
=13 + 1.3 (mstrument modude)
+5 + 5 [system)

+33 + .33 (system)

S0 A M) W, B AR 3T AR FRAL % K AR R
;2. bR

¥ BT KA B AR

1. #%# Audio Test;%k &£ # Run,

2. B EERE. 5AA2-3 WA REHILE,
3. 1R AR B E 69 = 52 %‘iﬁ% 7 JE A 1

4. BEph e, L da/ RaE

BRAIKFH A X

Ho i 2R IR A 4 ) B R T A B — TR A IR B P 69 sk
# b, KR AR £ DOS6.x FAT xﬁro R e IO E B
2 M MR L RETRAEGR EE P,
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EZ M X E B —7k 3.5 & ,1.44MB #& XA T 69 2kmk &

B X T 0T, B R E R R AR T, 0 P E RPN E
MM K K. M XK BLFE T Y B

o 41— B

o NEE XA G AN—
o X

o FHATIF Mo

o fEKIEA Ko

1. A& P REHIL. 50317 A XK
2. ## Floppy Drive Test; 4k 5 £ 4% Run,

Jo B AR W] X B AT Bl ILAE IR, AR L ) Rk A R
LR PIREN X L. SRR AR, e RIS P R kK
M X P AT o

Z:% NetTek 5L -F & 6935 M X kK, 75 R L EB T IR A,
WA RS F I, SO IX R E6gBIRN A,

% 3l

A

R IR, 3-6

Mt F,1-3

BRIk W, ¥, 1-4,B-2

R A IR IR A (IR @),B-3
(#k)4E #,B-2

R4t (e,),B-3

@ A,B-2

A4, B-1

A P F#,B-1
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EHLE, R, F A,1-3
Hohk, & #,iX
i, A4 5 Be,3-15
WA 45,115

B

FEh, AR B HX,3-11
W,

#10,3-4

& E,1-3,3-3,3-8
#%,3-5

B B WAF,B-2
A% F970,3-3

% %,3-7

¥ & KF,1-8,3-5
A #7,3-6

945,38

" 2R,3-7

KF,3-5

% E,3-4,3-7

Bt e, 3-7

#,w %,1-3,3-8,B-2
7o, B A, 34
fa=,1-5

% 4 %, %,3-3,3-8
=48\ A g H2,3-6
F4.,3-5

¥ %,1-19,2-3,3-5,3-6
2 %,1-5

42 % 1,3-3

& 22 W,k ,3-3

B AT i e, 3-6

% ,1-4,B-2
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oy 3£ ,1-5
EZAY

¥ #p,1-8

A% B, 1-7
#%#,3-10

Z K ,1-6

A X %,3-3

% 14-,3-3
éﬁ_,ﬁk%/—\ -4
BRI, A-
ﬂ:ﬁ,3-3,3-4

R, R4, 34
A 3:,3 2

N E &, kA (RE),3-15
M 17,1-12

Eoiih

*@,2-7

# 85,2-10
#£)7,2-6

I AB42.2-7,2-8

C

w40

RS-232,B-1

B

W, 4, 3-8
SRR AW 35,3-9 R 4474, 3-9
i 8] K (3E 89),3-9
B R AE,1-20

fik ¥ B, X 45 8.,1-20
B IKE,3-5
*

AKX M ,3-19

www.tek.com.cn 76



YBT350C NetTek 54X -F &

He 7 #,3-19

%) fF 7R 25,3-19
PC,%%#.,3-19
Wiz

#

##,1-3

#%,1-4

= 1-4
CD-ROM,1-3

% % ,A-6
BETRE

F=H #,3-2

A 542,32

W, W, 3-7
7w B e ,3-7

¥ 542 % ,3-5
#iEuteA,C-3

1§ 47,31
i#13 E #,3-1
FLE, A%, % %,3-1
H¥

& X w4t 2,1-10
F B R 111
B R 4 n,iX

H 4 Fw o, 3-3,3-8

=4 M
W, 32,3-6
BEIKE,3-2
= 4,2-2

D

2@
K #7,2-5,2-7
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Wik ,2-5

A2 5 4240,2-6

& K E,2-6

K& R,2-6

1£ 4%-4,2-5

7l ) 4X,,3-1,D-1

% Wit 3k,D-2
Xk 4,D-2
X5t 9,D-4
JH,5h3R,A-8

R B H,3-17

K E,2-4
EHEH,3-17

A AE,1-20

B AR A7, 3-11

fik 32 5, 2-1

* A kA e X,3-11
A, 4T H,3-2

IT A AL e ¥ 2,1-12

E

IRBTHAHLTE(F1F),A-6

F

% M1t %,D-3

E A X $,3-2

B IAZ &, B #H 8h,2-10,3-2
B

IR 5, I+ R 481F,B-3

X5 A% F ,2-4

He#R,3-17
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H5,3-17

)8 #1,3-2

A&

N & #,3-15

#4%F,(PC ¥),3-20

B 8 AR, 45 %) Fe 48 0 35,2-2
) e e &

W, R 4E18,1-19

M (FE )47 &,1-19

H

F 4%, 4% 35,1-17

H, oA, #44,1-18
A, F B 4,1-22,2-2
A, E I x E ,2-4

#5 B

A Az 8:,2-10,3-2

A #7,2-10

& 842 7,2-6

B, A H,1-4

/0,2-3

HAAGE,1-2

B AT

?,2-10

£ ®,2-5,2-7

AL S, 2-11
E(#5:K),2-6,3-7

K 4,2-6

5 #(42), £,3-6

i~ %],PCMCIA 3% =,3-20,D-7
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A4, 8 31,3-2
FCRORE
W, 28, 3-5
27,2-3
Hu ¥,,2-3
< 8,133 4 84,2-10,3-2
2190 % (IR) 18 15 ,3-21
sh AL F,2-3
HM L AF,3-23
Rk A, 3-21
¥ ,3-25
i AT PP AL, 3-24
5 (% 3R), & 8 1A &,1-23
W NFedr 5% v ,2-3
BN AR, i NG 2 54 2-
I
w4, 1-5
BUAEAEH,1-11

=,1-16
PC +,3-19
J& 117
A4 424,1-18
6 & (DA B), B4 ,2-1
BEAEH,1-3
2% 1-11
H#p,1-14
2 51,31
KHLE T W Ty X,,3-12
A 45 W 2R 35,5 5,302
IR. &AW 4o &8 43
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(3R) dr N4t #,2-9
Sy N H550,2-3
A ,1-3
#4F,B-2

L

B35, ZEEM,1-3
LCD,#t.80,A-2

W v, B A H A E1-23
A e B 47,3-7

48(- % F) 2 ik,3-3
a2,

®#,3-17
ABUFEAE e 2 4,2-11

41 2 ,2-2
7T R DR
F+ 335 v ,D-9

& 5% o ,D-8
&= 457 25,1-19,2-3

4t 37,C-1
i

W 3R, 2-3
¥4 wg,3-11
5, A 7 ,1-4,B-1
Ak 35

i & 5Bt 3-15
N & 7% #%,3-15
#%,3-15
ok #%,3-15
Wik, 3-15
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PC +,3-15
PCMCIA,3-15
RAM,3-15
ROM,3-15

X

»LEA,3-1
X,3—2

E (R E),3-2

# 85,2-10,3-2
Fo AT 37 7F,2-8

Fn AT 4% 1 ,3-1

#2 5-,3-1

2 47,3-2

X #,3-2

% M %R ,3-2

2 #,2-6,3-1
]

Iy NF5 3L, 2-4
N B1e B ,2-4
W (RS F, B #,3-2
e

B 23,1-3

Ft4%,3-1

o)

Falin

S AE,3-2

F2 5 Fo A £,3—2
Ak

3% # (), 2-1

% %:.,1-2

% E, W, 3-4

i A, AR 8 () 4%),3-8
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oAk 01, i, 3-6

P

Z 4y e, %,C-4
FEEH 2 AL F,2-3
PC +,4%3.,3-19
PC 4 #-,3-1
PCMCIA

424 PC F,3-19

3 a

17 7],3-20,D-7

11 & ,2-4

W35 5 B, R E,IX
(45 %) A 47,3-6
%0

Sh 4 #,2-3

A AL E,2-3
IR(4x 4 4)45 & ,2-3
3 8%,2-3
PCMICIA,3-20,D-7
11 & ,2-4
RS-232,2-3

W, R
R, R A4
w4 (¥w.45),B-2
NG UL B ,2-4
& 19 W, 3, 3-3
A (F 4),3-11
X

AL EAE S, 3-11

B3 A E,3-11
7%,3-13

A 45 TR 4],3-13

www.tek.com.cn 83



YBT350C NetTek 4 #iLF &

I %,2-2

% He,1-22

% W, 5 M4, 1-21

Fm

2 AL 1-19
et D, 1-19

A,

100 %] 240VAC,1-10
12VAC,1-11
£,1-3,1-10
%m,1-3,1-11

¥, 7 X,3-11

9P, (K 2T 5, 3] IR 479 0,3-24
7 o

P, 1-1

4 E,1-2

XA R AT G

A2 5 ¥ 41,2-6

2 /5 R #,3-1

R

HEER, w3, Vi

i 3% W 4,31

Y #p

W, ,1-8

PR A, 1-14

#* ¥ w,3.,1-5,3-10,B-2
TE

F ) kA 5+ 4%,3-1
A Ak,1-22,2-2
B4, 1-22
RS-232

W, 47,B-1
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% =4 54i_§,2'3
—#/7,3-2

£

\

(%
AN

\

S

7

A @,iv
Y

¥ ,3-11

B45 (B4 )% 97, B 3%,1-4,C-1

B

&5 &) 4% 4% 37 ,1-4,2-1,C-1
kL, ik 2,1-4

£ E ¥ X,3-11
B3 AR A,3-11

A A, e, 1-19

AR 4

W, 4,3-3

T HL B AL B iX
XE

% x,3-2

X #.,3-2

i Hy, 4o 4T 6,3,C-4
JAH &, 1-4

x A
SRR, 1-21
X#.,3-2

B3 (7F R),2-8
Ak

I BAUE AL, 2-11
F %,1-22

&AL, Viii

FE, A E v X,3-13
8 AL E,2-4
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BLEA (B AIIE),A

W, i, A-1

27,A-2

W, 44, A-1

7 355,A-4,A-6

% #,3-17

B N g o A-2
1R 8,4 44,1-4,1-15
WK S,1-21
=2

% #,3-2
AUEAE S, 3-1

¥ % 2-6,3-1

&, e ik,1-19,2-2
RS

X (R ), % &,2-6
A #7,2-6
Ak, S R, I 4,3-20
Fhk AT @ s B L,2-3
Bt i, 3-4
BRAH%EH -4
z=%.,1-18

T2 Rk#,1-18

A

#iz,1-4

28 117

fik %,1-4,2-1

RAE X HE,1-20
iz
HHALEF,1-21
AT @, I 5, 1-21
¥, 3-11

fr & ¥ #,3-1
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ﬁﬁa %$53_1
T

=542 (%)
BEKE,3-2

& X\ xm,2-5
BRI HFH FKAE L, X
B3, IK A X

2, i e, 3-7
3%, 3 5 Fe i 4,31
UURE

#-b7,D-1

o, 1-19

F6 W ¥B4T,1-12

17 44 42

M4, 1-4

I %(4),1-15

B 1), PR A 12 4T,3-6
T A 2(5),440,2-7
Je AT 4% A ,2-8

ik 32 5, 2-1

A AE,1-20

K E R HE,1-20

% B4+ fik d e,1-20
15 3% 5 AL, C-3
SR X AW, wi,3-3,3-8

U

I+ 48, % & 3K 3 4844, B-3
URL, & #,,ix
&R ¥ ,3-1
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\'

R A, BRAT B A Vil

w

P 3k, 25 %,,iX

TF

HHALF & ,A-8
MR, % 44,1-18
ALE w8, 8 5,3-2
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